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[bookmark: _Toc110617820]Introduction
[bookmark: _Toc110617821]Document Description
The ABEX Thermal Desktop User’s Guide will provide a general overview of Thermal Desktop and how to use it for the purposes of modeling/simulating TPMs.
[bookmark: _Toc110617822]Scope of Applicability
This document will act as a guide to installation as well as utilization of Thermal Desktop as relevant for implementation by ABEX.
[bookmark: _Toc110617823]Reference Documents
The following project and subsystem documents should be referenced as needed.
[bookmark: _Toc110618297]Table 1: Relevant project documents.
	Project Document Name
	Description of Document

	Project Summary
	An overview of the ABEX mission and major elements.

	Requirements Document
	List of project requirements with V&V allocations.

	Name
	Short description of document


[bookmark: _Toc110617824]Getting Started with Thermal Desktop
[bookmark: _Toc110617825]Thermal Desktop 
[bookmark: _Toc110617826]Licensing AutoCAD and Thermal Desktop
Licensing for AutoCAD is available through the universities involved in ABEX. To gain access to AutoCAD, create a student account with Autodesk at https://www.autodesk.com/education/students using your university-provided email address.  
Trial licenses for Thermal Desktop are available to university students. To gain access to Thermal Desktop, request a trial by completing the form at https://www.crtech.com/trial, making sure to use your university-provided email address. It is not necessary to check the “I need a trial SpaceClaim license” box. After completing the trial request form, a C&R Technologies representative will contact you to ask how Thermal Desktop will be used. Once your trial request is approved, you will receive instructions on how to install Thermal Desktop. It is crucial that these instructions are followed exactly as written.
[bookmark: _Toc110617827]Introduction to Thermal Desktop’s User Interface
[bookmark: _Toc110617828]Ribbons
Thermal Desktop adds three ribbons to AutoCAD: the Thermal, Thermal2, and Fluid ribbons. 
· The Thermal ribbon contains tabs for:
· FD Surface/Solid
· Grips, Network
· Articulators
· FloCAD
· Preferences
· Post Processing
· Common
· Modeling
· Model Checks
· Environment.

· The Thermal2 ribbon contains tabs for:
· Measures
· Mesher
· TD Direct
· Import
· Export
· TD Block Ref
· Utilities
· The Fluid ribbon contains tabs, some of which are repeated from the Thermal ribbon, for:
· Common
· Create Fluid
· Pipes
· Paths
· Ties
· Create Thermal
· Commands
· Post Processing
· Modeling
· Preferences
· Utilities
[bookmark: _Toc110617829]Sidebar
Many, if not all, the icons available in the tabs within the Thermal, Thermal2, and Fluid ribbons can be accessed in the two sidebars are quick access.
[bookmark: _Toc110617830]Right-Click Tricks
· Right-click Customization:
· Tools > Options > User Preferences > Right-click Customization
· Tricks:
· Right-click object > use Properties of this Object as Default.
· effectively create a template for similar objects of the same type.
· In the case set manager > right-click a case > Set Symbols, Aliases, Override Databases to Global.
· When you’re done, repeat previous steps > Reset Symbols Back to Global Values
· If you select Edits always on the comment page other users can’t ignore the notes about the case.
· In the Expression Editor windows, symbols and built-in constants are quickly available by right-clicking. Similarly, NEL shortcuts are available.
Relevant video(s): Right Click Tricks
[bookmark: _Toc110617831]Preferences
[bookmark: _Toc110617832]Setting Units
Model units in Thermal Desktop are set under Thermal > Preferences > arrow in the bottom right corner. Units can be changed at any time, and the model updates automatically to reflect changes. Units can be changed individually, or buttons can be used to shift between SI and English units. The “Don’t scale model to new length units” option is useful if you think you are working in different units than was set. The user sets units for lengths, pressures, heat fluxes, etc. Units must be manually applied to material properties that are not predefined in TD. Derived units are based on the based units. Entries will be automatically converted to reflect the model units, so if you enter a value in BTU/hr-ft2 and your global units are in W/in2, your value will automatically convert to W/in2. Units in Thermal Desktop logic must reflect the units of the model.
Relevant video(s): Units in Thermal Desktop
[bookmark: _Toc110617833]Setting Defaults
Thermal Desktop populates many fields with default values for created objects. Often these settings will need to be changed after creating the surfaces. Settings to change defaults are under Thermal > Defaults. Thermal Desktop defaults can be used to speed up model creation, offer ideas on how it might be used, and explain how to use objects as a template for future objects. Instead of editing settings after the model is used you can edit the default setting beforehand in Thermal > Defaults. Once the defaults are set and the object is created under them that object can be used as a template for similar objects so that the properties of each object don’t have to be changed individually.
Relevant video(s): Using Defaults
[bookmark: _Toc110617834]Visibility Control
Visibility controls in Thermal Desktop allow you to change model visibilities and styles to make viewing easier. To do work on certain objects, they must be made visible.
[bookmark: _Toc110617835]Basic Visibility Control
The visual style of the model can be changed in manners such as wireframe, 3D wireframe, Hidden Wireframe, and Shaded Thermal. Object Visibility can be controlled by type (surfaces, nodes, heat loads, etc.) Most of these modes can be activated by icons on the ribbon. Visibility settings can be made for specific surfaces or walls to give a view of the internals of the model.
Relevant video(s): Basic Visibility Controls in Thermal Desktop
[bookmark: _Toc110617836]Model Browser
The model browser is used to control the visibility of the model. It allows you to turn layers off and on, display desired parts for viewing, highlights and unhighlights selections. Basically, controls what you see from the model on the screen. The output window indicates whether the selection is visible and why. Layers in the selection are shown as visible, off, or frozen. Turn on layers with right-click > Turn on Selected Item’s Layers. Selections can be quickly turned on and off using the TD light bulb icons. Display Only and Display All control object visibility. To highlight selections: Display > Highlight Selection, then > Unhighlight Selection. Node and lump IDs can be turned on and off using the “123” light bulb icons. Warnings and error messages may contain unique AutoCAD handles (::xxx format).
Relevant video(s): Controlling Visibility with Model Browsing
[bookmark: _Toc110617837]Layer Visibility Control
All graphical objects in AutoCAD exist on layers that can be separately controlled. When you draw an object, it will be created in the Current Layer. Change an object’s layer by selecting it and then using the Control Layer pull-down to select the new layer. The snowflake/sun icons are used to freeze/thaw a layer. 

[image: ]
[bookmark: _Toc110618304]Figure 1: Layer Control Pull-Down Menu
Objects on a frozen layer are not visible and cannot be selected. It is recommended that freeze/thaw are used instead of the on/off lightbulbs. You can override an object’s color by changing ByLayer to a specific color.
[image: ]
[bookmark: _Toc110618305]Figure 2: ByLayer Pull-Down Menu
The Layer Properties Manager can be accessed by clicking the Layers [image: ] button.
· After creating a new layer, you can name it and set its color.
· New VP Freeze will freeze layers in new viewports, which includes postprocessing views.
· Selecting New Layer VP Frozen in All Viewports will create a layer with New VP Freeze set.
· Do not Lock layers. It is not a supported function within Thermal Desktop.
· AutoCAD will not let you delete a layer with objects on it.
· Thermal Desktop creates RADCAD layers for postprocessing and orbit displays.
When displaying a viewport, the layer manager will have a column to freeze the layer in the active VP. Layers can be made for different types of components such as ducts, conductors, etc.
Relevant video(s): Layer Visibility Control in Thermal Desktop
[bookmark: _Toc110617838]Case Set Manager
Case set manager defines the exchange between TD and S/F. The case set manager gives access to modify the radiation tasks, the calculations tab allows you to select the calculations that you want to make. The output tab allows you to adjust the setting of what is output by the model run. The SINDA tab allows you to view and control the user-defined interfaces between TD and S/F. The Dynamic tab allows SINDA to ask TD for new files and is more detailed in other videos. The advanced tab is used to set initial temperatures and lumped states. The symbols tab allows the value of symbols to be overridden. The comments tab is to comment on what the case is for or leave helpful notes. Always save the model before running.
Relevant video(s): Case Set Manager
[bookmark: _Toc110617839]Modeling Basics
[bookmark: _Toc110617840]Importing Files
To import files from other CAD environments, such as SolidWorks:
1. Type IMPORT in the command line.
2. Choose the .STEP file to be imported.
a. If the model is not in. STEP format, export the file to this format before importing to AutoCAD.
3. Open the file by clicking the link to the file location on the notification in the bottom right-hand corner of AutoCAD.
4. If the model is not immediately visible, zoom out. 
[bookmark: _Toc110617841]Best Modeling Practices
· Simplify geometry.
· Bolts, chamfers, fillets, and bolt holts provide little to no benefit as scaffolding.
· To prevent accidental changes to AutoCAD geometry, you should lock layers.
· Only lock layers that are geometry only. Thermal Desktop objects should not be used on locked layers.
Relevant video(s): Using CAD for Scaffolding
[bookmark: _Toc110617842]Surfaces and Solids
Models in Thermal Desktop can be created in either 2D or 3D. This is done using the “FD Surface/Solid” panel in the Thermal ribbon, as seen in Figure 1.
[image: Graphical user interface
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[bookmark: _Toc110618306]Figure 3: FD Surface/Solid Panel
For each primitive element listed above, follow the requests for input in the command line. These provide guidance on what axis to select a point from. It should be acknowledged that these elements are not immediately thermally connected to any other models, nor are temperatures of or heat loads on the objects assumed. To thermally connect primitives, nodes are needed. Inputs will be applied individually using methods covered later. 
Relevant video(s): Welcome to Thermal Desktop
[bookmark: _Toc110617843]Property Application
To edit material properties:
· Thermal menu > Thermophysical Properties & Optical Properties.
Thermal, surface, and solid properties can be applied directly when mesher are created. Any edits to properties applied to meshes will affect the entire mesh.
Relevant video(s): Welcome to Thermal Desktop, TD Mesher Basics
[bookmark: _Toc110617844]Nodes
To create nodes: 
· Thermal ribbon > Network Panel > Click the [image: ] (Node) shortcut.
· or Thermal menu > FD/FEM Network > Node.
· selecting thermalàFD/FEM NetworkàNode.

To edit nodes: 
· Select the node to be edited > Thermal menu > Edit.

Note that nodes are thermally isolated unless conductors are created to connect them.

Relevant video(s): Welcome to Thermal Desktop
[bookmark: _Toc110617845]Contactors
Contactors are used to create thermal contacts between Thermal Desktop objects. Contactors connect the closest nodes, account for partial connections, and automatically recalculate if parts move or change.
To create contactors:
1. Thermal > FD/FEM Network > Contactor
2. Select “connecting from” objects.
3. Select “connecting to” objects.
4. Enter Conduction Coefficient.
5. Modify any other inputs as necessary.
6. Hit “Show Calc” button
	[image: A diagram of a house
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[bookmark: _Toc110618307]Figure 4: Active Faces (Left), Active Edges (Right)
Options for contactors are Face contacts and Edge contacts. The values can be input per area, per length, or per absolute. The contactor material is chosen, and the material provides the conductivity through the interface. Radiation conductors are used for simple interfaces with known view factors. Insulation can be applied between parts, the contactor must be selected to be underneath the insulation or connected to the insulation. Check connections by displaying contactor markers. The faces and edges that participate should be limited for efficiency. Some common mistakes are connecting from large areas to small areas, connecting from centered nodes, modeling perfect contact since it is not accurate, and nodes should be merged.
Relevant video(s): Modeling Thermal Contact with Contactors
[bookmark: _Toc110617846]Loads
To add a heat load:
· Select Object > Thermal ribbon > Network Panel > Click the [image: ] (Surface Heat Load) shortcut.
· or Thermal menu > FD/FEM network > Element > Heat Load on Nodes > Select node.
There are options for creating non uniform heat loads. Arithmetic surfaces with heat loads and contactors can be created effectively. Physically this will look like surface strips where all the heat will move straight through the contractor into the surface underneath. Radiation must be excluded to ensure all heat goes through the contactor. Network Element Logic can be used on nodes to create expressions for heat loads. 

Relevant video(s): Non-Uniform Heat Loads

[bookmark: _Toc110617847]Boundary Conditions
Boundary Condition Mapper:
· Initial temperature can be mapped onto models.
· Advanced mapping has been added to search for the closest mapping point.
· Eliminates the need to set progressive tolerance levels. 
· Improves the mapping accuracy. 
· Time XYZ mapper (Closest point to mapper)
· Maximum tolerance limit can be set. 
· Stack symbol mapping allowed.
Relevant video(s): Thermal Desktop and RadCAD: What’s New in 6.1?
[bookmark: _Toc110617848]Steady-State Solutions
The default setup for running models in Thermal Desktop is steady-state.
To run a model:
· Thermal menu > Case Set Manager > Click “Run 1 Selected Case.”
Relevant video(s): Welcome to Thermal Desktop
[bookmark: _Toc110617849]Meshes
[bookmark: _Toc110617850]TD Mesher
TD Mesher is a basic Mesher that provides a middle ground between Thermal Desktop primitives and a full featured Mesher. TD Mesher meshes parts in thermal desktop but does not mesh assemblies. Parts to be meshed should be cleaned up to have only simple geometries that are important for thermal analysis. Meshes between parts are difficult to match. TD Mesher uses minimal part-level control. TD Mesher generates triangular surface meshes and tetrahedral solid elements. Extrude and revolved Mesher types generate prismatic solid elements with triangular elements at the ends. The types of meshes created with TD Mesher include free mesh, extrude mesh, and revolve mesh. Free mesh creates a mash for a surface or solid body to mesh a part. Extrude mesh selects objects of exploded bodies the base sides and end of object can be selected individually for meshing. Using Extrude you can make the mesh more custom and uniform than a generated free mesh. Revolve mesh, like the extrude but the mesh is created around an axis of revolution. Symmetry functions are only applicable to extrude and revolve mesh types.
[image: A screenshot of a computer
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[bookmark: _Toc110618308]Figure 5: (Left to Right) Revolve, Extrude, Free, Free Surface
The procedure for creating a mesh is as follows:
1. Select mesh type (Mesh, Extrude, Revolve).
2. Select part geometry.
3. Generate mesh preview.
4. Define thermal properties (Node, surface element, and solid element properties).
5. Generate mesh.
When a part is meshed a mesh controller is created which outlines the meshed part. To when the part is copied the mesh and solid are both copied. To move a part or mesh, the part and mesh both must be selected. 
[image: Table
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[bookmark: _Toc110618309]Figure 6: Descriptions the TD Mesher menu, toolbars, and ribbon icons
Relevant video(s): TD Mesher Basics, TD Mesher Advanced Topics
[bookmark: _Toc110617851]TD Direct
TD Direct is useful for meshing complex geometries, such as around holes
Relevant video(s): Using CAD to Create Thermal Models
[bookmark: _Toc110617852]Meshing Around Holes
There are multiple methods of meshing around holes in Thermal Desktop.
· Method 1: Disable a node at the center of a Finite Difference surface.
· Set a node from a 1 to a 0 to disable it.
· Method 2: Manual meshing for coarse nodalization.
· Involves creating strategic lines to approximate the circular hole shape. 
[image: A picture containing shape
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[bookmark: _Toc110618310]Figure 7: Visual Representation of Manual Meshing
· Method 3: TD Mesher.
· Use REGION and SUBTRACT.
Relevant video(s): Methods of Putting a Hole in a Surface
[bookmark: _Toc110617853]Postprocessing
Postprocessing allows you to review the data from runs made of your model. There are settings that allow you to select the desired outputs and form you want to see them. The model can be stepped through time and specific times can be chosen to see the thermal effects on the model. The color bar can be edited and temperature ranges for colors adjusted to give more detail in output. Nodes can be selected to give temperature versus time plots for the node. Time can be cycled through to show an animation of your model through time.
· Start by selecting information in the Case Set Manager to write to the save file.
· Make sure you save the relevant information.
· Data point frequency is set by the Output Increment.
· Find the balance between file size and frequency.
· The viewpoint can be resized and repositioned using grip points.
· Change the currently viewed time by clicking the Next/Previous time step buttons in Thermal > Post Processing.
· Cases can be switched between using Thermal > Post Processing > Postprocessing Manager.
· Edit Layout Colorbars is the colorbar settings menu.
· Cycle Color Bars is used to quickly switch between node, lump, path, tie, and file data.
· The EZ-XY Plotter displays temperature by default but can be customized for any parameter.
· Cutting Planes are used to see temperatures inside solids. There is a separate video on this subject.
· Graphical delays are used to slow down videos that are too fast.
Postprocessing with cutting planes uses cutting planes in postprocessing to view slices inside solids. To create a cutting plane, select Thermal > Postprocessing > Cutting Plane. Select the origin and length to cut the solid. Cutting planes can be postprocessed the same as any thermal model object.
[image: ][image: ]
[bookmark: _Toc110618311]Figure 8: Visual Representation of a Cutting Plane
Relevant video(s): Introduction to Postprocessing, Postprocessing with Cutting Planes
[bookmark: _Toc110617854]Advanced Topics
[bookmark: _Toc110617855]Symbols/Registers
· Symbols are useful for variables that change between cases.
· Some examples are power dissipations, contact coefficients, beta angles, or when there are separate hot/cold cases.
· The Case Set Manager is used to override symbols.
· Select > Edit > Symbols.
· Registers vs. Symbols
· SINDA/FLUINT doesn’t need to know about all symbols
· Thermal Desktop doesn’t need to know about all registers
· Symbols in expressions sent to S/F should also be sent
Relevant video(s)
[bookmark: _Toc110617856]Logic
[bookmark: _Toc110617857]Expression Editor
An expression is an applied definition that can change with time. To add an expression, double click a field to open the expression window.
[image: Graphical user interface, application
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[bookmark: _Toc110618312]Figure 9: Steps for Accessing Expression Editor
Relevant video(s): Network Element Logic
[bookmark: _Toc110617858]Logic Manager
The Logic Manager is used for global logic. Some considerations when using the Logic Manager:
· LM list order is important 
· There is no relationship to network elements, other then IDS 
· If this logic does not apply to a case, disable and use symbol override
· Upshot: the best location for logic that is applied to all or most cases and that isn’t specific to any one network element path or node  
Relevant video(s): Network Element Logic
[bookmark: _Toc110617859]Reliability Engineering
In Reliability Engineering, uncertainties and unknowns are treated statistically. Random Variables are the registers that represent these uncertainties in dimensions, environment, properties, etc. Optionally, you can add reliability constraints (failure definitions on these responses). Reliability engineering allows for robust design, in that it can be used for optimization and allow for the avoidance of under-design and over-design.
The methods for predicting reliability are SAMPLE, DSAMPLE, and RELEST, and these methods are explained in the chart below:
[image: Table
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[bookmark: _Toc110618313]Figure 10: SAMPLE, DSAMPLE, and RELEST Reliability Methods Explained
Relevant video(s): Introduction to Reliability Engineering Module
[bookmark: _Toc110617860]Optimization and the SOLVER Module
SOLVER is a part of the Advanced Design Modules (ADM). It is a way of assigning high-level tasks to either SINDA/FLUINT or Thermal Desktop. The SOLVER module aids in preliminary design sizing and selections, allows a user to solve for input values given desired responses, helps optimize existing point designs, can be used to correlate models to test data, and automates the search for the worst-case scenarios. The SOLVER autonomously changes one or more registers until some analysis objective is met. Registers are a “control panel of knobs” for centralized model changes.
[image: Diagram
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[bookmark: _Toc110618314]Figure 11: Visual Explanation of SOLVER Terminology
Relevant video(s): Introduction to Optimization
[bookmark: _Toc110617861]Network Element Logic
User logic in TD ultimately follows Fortran rules. Calling functions and subroutines in important to learn. Logic can be inputted in TD through the Case Set Manager (CSM), Logic Manager (LM), and Network Element Logic (NEL). It is suggested that the sub model logic location in the CSM is only used in special cases since the logic cannot automatically propagate to other case sub models. The LM can apply logic to all, or most cases and the logic must be disables using a symbol override for cases that the logic does not apply. List order can matter when inputting logic using the LM and all network relationship are hard-wired ID’s. 
Access NEL by Add Code button or Edit code button is code is already added. When using expression like logic, the logic can be repeated. Network logic should be appropriately placed, or the execution may not be applied in the desired manner. NEL is basically super expressions that can execute complicated operations. Logic units must be one of the two SINDA/FLUINT standard unit sets (SI for us). If an asterisk is next to an element in the model browser, it has logic applied. NEL is a logic generator when used for multiple elements. NEL is a hybrid of C-like expressions and Fortran-based user logic.
Example: Stop transient when a temperature reaches a limit (logic applied to a single element)
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[bookmark: _Toc110618315]Figure 12: Logic Applied to Single Element
Example: Global logic (only location is important; what code does is not the concern.)
[image: Graphical user interface, text, application, email
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[bookmark: _Toc110618316]Figure 13: Logic Applied Globally
Relevant video(s): Network Element Logic
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[bookmark: _Ref95039776][bookmark: _Toc110617863]Acronyms & Terminology
[bookmark: _Toc110617864]Acronyms
	Acronym
	Definition

	ABEX 
	Alabama Burst Energetics Explorer 

	APRA 
	Astrophysics Research & Analysis  

	ASGC 
	Alabama Space Grant Consortium 

	CAD 
	Computer-Aided Design 

	C&DH 
	Command & Data Handling 

	CDR 
	Critical Design Review 

	CE 
	Chief Engineer 

	CLB 
	Configurable Logic Block 

	COTS 
	Commercial Off The Shelf 

	CS 
	Chief Scientist 

	CSLI 
	CubeSat Launch Initiative 

	DAC 
	Design Analysis Cycle 

	EAR 
	Export Administration Regulations 

	EPMs 
	Educational Performance Measures 

	EPS 
	Electrical Power System 

	FPGA 
	Field Programmable Gate Array 

	FSW 
	Flight Software 

	GN&C 
	Guidance, Navigation, & Control 

	GPS 
	Global Positioning System 

	GRB 
	Gamma-ray Burst 

	GRD 
	Gamma-ray Detector 

	HV 
	High Voltage 

	ICP 
	Instrument Calibration Plan 

	IMS 
	Integrated Master Schedule 

	IMU 
	Inertial Measurement Unit 

	ISM 
	Integrated Systems Model 

	ITAR 
	International Traffic in Arms Regulations 

	IV&T
	Integration, Verification, & Test

	KDP 
	Key Decision Point 

	KPPs 
	Key Performance Parameters 

	LSE 
	Lead System Engineer 

	MBSE 
	Models Based System Engineering 

	MCR 
	Mission Concept Review 

	NDA 
	Non-Disclosure Agreement 

	NIST 
	National Institute of Standards and Technology 

	PC 
	Program Coordinator  

	PDR 
	Preliminary Design Review 

	PIU 
	Payload Interface Unit 

	PM 
	Project Manager 

	POP 
	Period of Performance 

	QP
	Qualification Plan

	QR
	Qualification Report

	QPSK 
	Quadrature Phase Shift Keying 

	SE 
	Systems Engineering 

	SEMP 
	System Engineering Management Plan 

	SIS 
	Software Interface Specification 

	SME 
	Subject Matter Expert 

	SMP 
	Software Management Plan 

	SQP 
	Structural Qualification Plan 

	SQR 
	Structural Qualification Report 

	SRD 
	System Requirements Document 

	SRR 
	System Requirements Review  

	STDP 
	Subsystem Technology Development Plan 

	STP 
	Subsystem Testing Plan 

	TCP 
	Technology Control Plan 

	TID 
	Total Ionizing Dose 

	TPM 
	Technical Performance Measure 

	TQP 
	Thermal Qualification Plan 

	TQR 
	Thermal Qualification Report 

	TRL 
	Technology Readiness Level 

	TT&C 
	Telemetry, Tracking, & Command 

	V&V 
	Verification and Validation 

	WBS 
	Work Breakdown Structure 

	XRD 
	X-ray Detector 



[bookmark: _Toc110617865]Terminology
	Term
	Description

	Acceptance
	A type of verification procedure specifically for testing and analysis. Acceptance test/analysis criteria show that the manufacturing/workmanship of the unit conforms to the design that was previously verified/qualified. Acceptance activities are performed on each of the flight units as they are manufactured and readied for flight/use (NASA Systems Engineering Handbook, 2016)

	Analysis
	Verification by analysis is a predicted compliance to requirements. The use of mathematical modeling and analytical techniques to predict the suitability of a design to stakeholder expectations based on calculated data or data derived from lower system structure end product verifications. Analysis is generally used when a prototype; engineering model; or fabricated, assembled, and integrated product is not available. Analysis includes the use of modeling and simulation as analytical tools (NASA Systems Engineering Handbook, 2016).

	Assembly
	The mechanical mating of components to form a system.

	Certification
	The audit process by which the body of evidence that results from the verification activities and other activities are provided to the appropriate certifying authority to indicate the design is certified for flight/use. The Certification activity is performed once regardless of how many flight units may be generated (NASA Systems Engineering Handbook, 2016).

	Configuration Item
	The combination of two components, subsystems, or systems of lesser complexity resulting in a combined assembly, subsystem, or system with greater complexity. Configuration Items exist at Integration Points; a sequence of Configuration Items along several Integration Points comprises an Integration Chain.

	Demonstration
	Verification by demonstration is an observed compliance to requirements accomplished by showing that the use of an end product achieves the individual specified requirement. It is generally a basic confirmation of performance capability, differentiated from testing by the lack of detailed data gathering. Demonstrations can involve the use of physical models or mock-ups (NASA Systems Engineering Handbook, 2016).

	Inspection
	Verification by inspection is a documented compliance to requirements. The visual examination of a realized end product. Inspection is generally used to verify physical design features or specific manufacturer identification (NASA Systems Engineering Handbook, 2016).

	Integration
	The process of combining less complex functions, understanding those functions, and controlling those functions to achieve a system satisfying its requirements.

	Integration Chain
	A series of Integration Points. Integration Chains can be represented as tree or fishbone diagrams where many components, subsystems, or systems of lesser complexity are combined as Configuration Items at Integration Points to create a system of higher complexity. Integration Chains are generally defined to realize a Technical Performance Measure.  

	Integration Point
	The location on a schedule where two or more components, subsystems, or systems of lesser complexity are combined as a Configuration Item with greater complexity. A series of Integration Points comprises an Integration Chain.

	Interface
	An interface represents a constraint based on the logical and physical boundary conditions between two or more entities within a level of abstraction, between System of Interest elements, between other mission systems, between enabling systems, or between the System of Interest and its Operational Environment. Interfaces can be for physical connection, energy transfer (power or heat), matter, or data (Wasson, 2016).

	Key Performance Parameter
	Those capabilities or characteristics (typically engineering-based or related to health and safety or operational performance) considered most essential for successful mission accomplishment. They characterize the major drivers of operational performance, supportability, and interoperability (NASA Systems Engineering Handbook, 2016).

	Mode
	An abstract configuration, condition, or process that occurs with or without a corresponding physical state in a component, subsystem, or system at a given time. A non-tangible, non-physical concept.

	Model
	A mathematical representation of reality (NASA Systems Engineering Handbook, 2016).

	Operational Environment
	The surrounding systems, materials, or occurrences defining a system’s ability to externally interact. The Operational Environment is comprised of a Human Systems Environment, a Natural Environment, and an Induced Environment (Wasson, 2016).

	Primary TPM
	A regular Technical Performance Measure, either a Key Performance Parameter, Technical Performance Parameter, or Technical Environmental Parameter; this distinction exists only as an organizational hierarchy.

	Qualification
	A subset of the verification program that is performed at the extremes of the environmental envelope and will ensure the design will operate properly with the expected margins. Qualification is performed once regardless of how many flight units may be generated as long as the design doesn’t change.

	Secondary TPM
	A subdivision of a Primary TPM for the purpose of representing portions of Primary TPM concepts within a Domain Knowledge Map. Secondary TPMs are not tracked or reported and do not required a target threshold. Secondary TPMs exist only as an organizational hierarchy for conceptual organization. Secondary TPMs can break down further into more Secondary TPMs.

	Simulation
	The manipulation of a model (NASA Systems Engineering Handbook, 2016).

	State
	A physical mechanical configuration, environmental condition, operational condition, or other physical condition that either happens to or is initiated by a component, subsystem, or system at a given time.

	Technical Performance Measure
	A set of performance measures that are monitored by comparing the current actual achievement of the parameters with that anticipated at the current time and on future dates (NASA Systems Engineering Handbook, 2016)

	Technical Performance Parameter
	Those capabilities or characteristics (typically engineering-based or related to health and safety or operational performance) considered relevant to operational performance, supportability, and interoperability at any level.

	Technical Environmental Parameter
	Those capabilities or characteristics relevant to the definition of system interactions with the Operational Environment.

	Test
	Verification by test is a measured compliance to requirements. : The use of an end product to obtain detailed data needed to verify performance or provide sufficient information to verify performance through further analysis. Testing can be conducted on final end products, breadboards, brassboards, or prototypes. Testing produces data at discrete points for each specified requirement under controlled conditions and is the most resource-intensive verification technique. As the saying goes, “Test as you fly, and fly as you test” (NASA Systems Engineering Handbook, 2016).

	Validation
	Validation of a product shows that the product accomplishes the intended purpose in the intended environment—that it meets the expectations of the customer and other stakeholders as shown through performance of a test, analysis, inspection, or demonstration (NASA Systems Engineering Handbook, 2016).

	Verification
	Verification is a formal process, using the method of test, analysis, inspection or demonstration, to confirm that a system and its associated hardware and software components satisfy all specified requirements. The Verification program is performed once regardless of how many flight units may be generated as long as the design doesn’t change (NASA Systems Engineering Handbook, 2016).
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Most UI issues can be solved by resetting the user’s interface.
1. Select the “Thermal” menu.
2. “Utilities”
3. “Reset Thermal Desktop User Interface”
If the AutoCAD Ribbon is missing:
· Type RIBBON in the command line or
· Press Crtl+0.
If the AutoCAD Menu Bar is missing:
· Type MENUBAR then enter a value of 1.
· Click the [image: ] button, then select “Show Menu Bar.”
If the Thermal and Thermal2 tabs are missing:
· Type THERMALRIBBON in the command line.
If the Fluid tab is missing:
· Type FLUIDRIBBON in the command line.

Relevant video(s): Trouble Shooting the Thermal Desktop User Interface
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